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Course contents

• Overview: Add and position graphics

• Lesson 1: Graphic basics: Pictures and drawing objects

• Lesson 2: Inserting a graphic

(Continued on next slide.) 
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Course contents, cont’d.

• Lesson 3: Positioning a graphic exactly where you want it

• Lesson 4: Floating graphics and keeping them in place

Each lesson includes a list of suggested tasks and a set of 
test questions.
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No matter the purpose and tone of 
your document, strategically placed 
graphics can add visual interest, 
support key points, and highlight 
information. 

Overview: Add and position graphics

Learn how to insert many types of 
graphics into your Microsoft® Word 
document and position them exactly 
where and how you want, including 
inside or beside a block of text.
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Course goals

• Identify a variety of graphic types that you can use in a 
document. 

• Insert those graphics. 

• Resize, group, and rotate graphics. 

• Precisely position a graphic on the page. 

• Align a graphic with text, including wrapping text 
around it. 

• Keep a graphic in place by using an anchor. 



Lesson 1

Graphics basics: Pictures and 
drawing objects
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Graphics basics: Pictures and drawing objects

Choosing a graphic starts off as a 
simple exercise: On the Insert
menu, you click Picture. 

That's when things can start to 
seem complicated. What does 
"From File" mean? What's the 
difference between Clip Art and a 
New Drawing? The Picture submenu
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About pictures and drawings

You can use two basic types of 
graphics to enhance your 
documents: pictures and drawing 
objects. 

The Picture submenu
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About pictures and drawings

See the image at left. 

The Picture submenu

1. The top three commands on the 
submenu are for pictures, which 
exist independently from your 
document.

2. The lower five commands are for 
drawing objects, which you 
generate from within Word.
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About pictures and drawings

Pictures are graphics that were 
created elsewhere and that you 
bring into your document.

The Picture submenu

Drawing objects are graphics that 
you generate from within Word. 
Examples are AutoShapes, drawings 
that you create from scratch using 
the New Drawing command, 
diagrams, curves, lines, and other 
shapes. 
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About pictures and drawings

The type of graphic you choose to 
insert is limited only by your purpose 
and your preference:

The Picture submenu

• Some types of graphics, such as 
clip art, have a two-dimensional or 
drawn effect that can look 
attractive as a logo, border, or 
accent. 
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About pictures and drawings

The Picture submenu

• A photographic image might be 
preferable in some instances. 

• Diagrams and organization charts 
can convey critical information in a 
business or academic document. 

• WordArt creates high-impact text. 

The type of graphic you choose to 
insert is limited only by your purpose 
and your preference:
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More about pictures

Imagine that you're creating a 
casual memo to distribute to your 
coworkers. Maybe you want to insert 
your company logo, a scanned 
photograph from your last vacation, 
or even just a fun piece of clip art to 
support a point and create interest. 

A document with pictures
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More about pictures

See the image at left. 

A document with pictures

1. A picture created with Microsoft 
Paint.

2. A piece of clip art.

3. A photograph.
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More about drawing objects

You're working on that same memo 
and decide that you want to add a 
diagram, an organization chart, or 
maybe even just a simple shape.

In Word, you can create all of these 
types of graphics from within your 
document.

A document with 
drawings
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More about drawing objects

See the image at left.

1. An AutoShape.

2. A diagram.

3. An organization chart.

A document with 
drawings
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More about drawing objects

These types of graphics are called 
drawing objects, or drawings, and 
they differ from pictures in a couple 
of key ways:

• Drawing objects do not exist 
independently from the 
document; they aren't separate 
files with separate file extensions. 

• Drawing objects don't look like 
photographic images; they’re 
usually flat, two-dimensional. 

A document with 
drawings
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More about drawing objects

To insert a drawing object: 

• Click Insert on the Drawing
menu.

A document with 
drawings

You can use the Drawing toolbar to 
insert some drawing objects, but 
mainly you'll use it to change a 
drawing once it's inserted. 
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The drawing canvas

The drawing canvas is a frame-like 
environment that helps you insert 
and arrange a drawing or drawings 
in your document.  It's especially 
useful when your drawing consists 
of several shapes.

The drawing canvas
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The drawing canvas

When you insert a drawing, Word 
places it on the drawing canvas by 
default. 

The drawing canvas

By contrast, the default behavior 
when you insert a picture is to 
embed the file into the document 
without using the drawing canvas. 
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The drawing canvas

• To change the drawing canvas 
itself, use the Drawing Canvas
toolbar.

• If the toolbar does not appear 
automatically when you insert a 
drawing, right-click the canvas, 
and select Show Drawing 
Canvas Toolbar.

The drawing canvas
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Test 1, question 1

The main difference between "pictures" and 
"drawings" is: (Pick one answer.)

1. Pictures are graphics that you bring into your document 
from an outside source; drawings are ones that you 
create within your document. 

2. Drawings are only appropriate in informal documents, 
such as holiday letters; for business-related material, it's 
best to use pictures. 

3. Creating a drawing object requires some artistic skills. So 
if you want to insert one, you should be prepared to 
draw. 
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Test 1, question 1: Answer

Pictures are graphics that you bring into your document 
from an outside source; drawings are ones that you create 
within your document.

Pictures exist as their own files, independent of your 
document. Drawings are an actual part of your document, 
and their file format is folded into your document's.
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Test 1, question 2

What's the primary role of the drawing canvas? 
(Pick one answer.)

1. Creates a colored border around a graphic. 

2. Helps you insert and arrange a drawing or drawings 
on the page. 

3. Helps you insert and arrange a picture or pictures 
on the page. 
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Test 1, question 2: Answer

Helps you insert and arrange a drawing or drawings on the 
page.

The drawing canvas is a frame-like environment that helps 
you arrange a drawing or drawings in your document; it's 
especially useful when your drawing consists of several 
shapes.
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Test 1, question 3

To insert a drawing, you use the Picture command on 
the Insert menu. (Pick one answer.)

1. True. 

2. False. 
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Test 1, question 3: Answer

True.

You insert drawings and pictures by using the Picture 
command.



Lesson 2

Inserting a graphic
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Inserting a graphic

Inserting any type of graphic begins 
in the same place: the Picture
submenu, which is located on the 
Insert menu. 

After that, the particulars of graphic 
insertion may vary depending on 
exactly what type of picture or 
drawing you have.The Picture submenu
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Clip art

The days of photocopying printed 
clip art from a book and then 
painstakingly cutting, positioning, 
and photocopying are long over.

Search using the Clip Art 
task pane.
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Clip art

Here’s how you’d insert clip art:

Click in the document where you 
want to insert the clip art.

From the Picture submenu of the 
Insert menu, open the Clip Art
task pane.

Search using the Clip Art 
task pane.

Use simple keywords to search for 
the subject matter you want.

Choose from the resulting images. 
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Pictures "from file"

If you've got a particular graphic on 
hand that you want to use, such as 
a photographic image:

1. Click From File on the Picture
submenu. 

2. Then locate the graphic on your 
hard disk, server, Web site, or 
other location, and insert it 
directly from there.

Inserting a picture from 
a file
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Pictures "from file"

By default, the file is embedded 
directly into your document and is 
saved with it the next time you save 
the document. 

If you want to keep the file size 
down, you can link to the picture, 
meaning that instead of actually 
placing the file inside your Word 
document, you add a link to its 
source. 

Example of a picture 
from a file
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Shapes

Shapes are drawing objects that 
you generate as part of your 
document, rather than bringing 
them in from a separate source.

They include lines, connectors, 
arrows, cartoon callout balloons, 
and many other basic drawings.

AutoShapes toolbar
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Shapes

To insert a shape:

1. Click AutoShapes on the 
Picture submenu. 

2. Select the shape you want on the 
AutoShapes toolbar. 

AutoShapes toolbar
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Diagrams and organization charts

Word offers a variety of diagrams:

Inserting a diagram

• Just click Diagram on the Insert
menu. The Diagram Gallery
dialog box appears with 
descriptions of each of the 
diagrams. 

• Double-click the one you want to 
insert.
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Diagrams and organization charts

When you insert an organization 
chart, the Organization Chart
toolbar appears to help you add 
content and set options.

Example of a diagram

For all other diagrams, you use the 
Diagram toolbar, which also 
appears automatically.
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Suggestions for practice

1. Insert a picture "from file."

2. Add clip art.

3. Add an organization chart.

Online practice (requires Word 2003)

http://office.microsoft.com/training/Training.aspx?AssetID=RP010264991033&CTT=6&Origin=RC010264821033
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Test 2, question 1

To get clip art images into your document, you: 
(Pick one answer.)

1. Send Microsoft a coupon redeemable for a printed book of 
10,000 images. 

2. Use the Clip Art task pane to search for images that fall 
under the category you want. 

3. Open the Diagram Gallery dialog box, and click the type 
of diagram you want. 

4. Download clip art from the Office Online Web site on 
Microsoft.com, save it in the My Pictures folder, and then 
insert it into the document. 
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Test 2, question 1: Answer

Use the Clip Art task pane to search for images that fall 
under the category you want.

Clip art images are categorized by topic. You can also refine 
your search by searching only in particular places and by 
limiting the results to particular media types. If you want 
more choices, you can also search for clips on Office Online 
by clicking the link at the bottom of the task pane.
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Test 2, question 2

AutoShapes are: (Pick one answer.)

1. Flat images that you create in a rendering program, such 
as Microsoft Paint, and then import into your document. 

2. A category of clip art that specifically covers cars, trucks, 
and other pictures with an automotive theme. 

3. A collection of graphical shapes, such as lines, curves, 
and arrows, that you add by using the AutoShapes
toolbar. 
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Test 2, question 2: Answer

A collection of graphical shapes, such as lines, curves, and 
arrows, that you add by using the AutoShapes toolbar. 

You select an AutoShape from one of the many menus 
available on the AutoShapes toolbar, and then click in your 
document where you want to insert it.
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Test 2, question 3

Organization charts and diagrams are inserted by 
using the Picture command on the Insert menu. 
(Pick one answer.)

1. True. 

2. False. 
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Test 2, question 3: Answer

False.

Organization charts are inserted by using the Picture 
command, but diagrams are inserted directly from the Insert 
menu.



Lesson 3

Positioning a graphic exactly 
in place
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Positioning a graphic exactly in place

Usually, inserting the graphic isn't 
the end of the story. Sometimes it's 
the wrong size; other times, it's in 
the wrong place. 

This lesson shows you how to fine-
tune the size and position of 
images you've inserted. You'll also 
learn neat tricks, such as how to 
copy, group, and rotate graphics. 

Moving and resizing a 
graphic
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Resize an image

When you resize most types of 
graphics, the same basic principle is 
at work:

Resize handles and 
pointers for different 
graphic types.

• You select the image, and then 
position the pointer over a resize 
handle at the top, bottom, sides, 
or corners of the image. 

• When the pointer becomes a 
double-headed arrow, you drag to 
resize.
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Resize an image

As you can see in the picture on the 
left, the pointer becomes a double-
headed arrow for all types of 
graphics.

1. Clip art or images "from file."

2. AutoShapes.

3. Diagrams.

4. Organization charts, which are a 
type of diagram.

Resize handles and 
pointers for different 
graphic types
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Resize an image

There is some variation in how the 
resize handles look from one image 
type to another, although they all 
resize in the same way. When 
selected:

• Pictures and clip art are 
surrounded by a solid border with 
resize handles that appear as small 
squares. Resize handles, pointers 

for different graphic 
types
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Resize an image

• AutoShapes sit on the drawing 
canvas and are surrounded by 
resize handles that appear as small 
circles. 

Resize handles, pointers 
for different graphic 
types

• Diagrams and organization charts 
are surrounded by a border of 
dense dots with resize handles that 
appear as small circles. 
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Move an image

As with resizing, the same basic 
principle applies to moving most 
graphics: You select the image, and 
then drag it into position.

Moving handles for 
different graphic types

Unlike resizing, there are some 
minor variations, depending on the 
type of graphic.
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Move an image

1. An image "from file."

2. The drawing canvas with a 
drawing on it.Moving handles for 

different graphic types

Moving handles differ for different 
types of graphics:
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Move an image

• For images on the drawing canvas, 
you can move both the drawing 
canvas and the image. 

Moving handles for 
different graphic types

• For images not on the drawing 
canvas, the four-headed arrow 
does not appear. 

• For diagrams, including 
organization charts, select the 
diagram, and then position the 
pointer over its border.
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Position a graphic within text

You position a graphic within text 
(for example, between words or 
paragraphs) the same way you 
position it elsewhere: by dragging it. 
As you drag, let the special insertion 
point guide you.

Use the insertion point 
as a guide.
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Position a graphic within text

By default, the graphic (and also the 
drawing canvas) acts like a text 
character, in that it moves with the 
text; if you insert an extra line of 
text before the graphic, the graphic 
will move down a line. 

Use the insertion point 
as a guide.

This type of graphic is known as an 
inline graphic.
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Copy, group, or rotate images

One of the benefits of the drawing 
canvas is that you can easily copy, 
group, and rotate the images on it.

1. Copying a graphic

2. Grouping graphics

3. Rotating grouped graphics

Graphics on the drawing 
canvas
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Copy, group, or rotate images

Copy. If you want to use an image 
more than once, you don't have to 
redraw or reinsert it; just click the 
image to select it, and then copy 
and paste the same way you do 
text.

Graphics on the drawing 
canvas
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Copy, group, or rotate images

Group. By grouping separate 
images, you turn them into a single 
unit that you can manipulate as a 
whole in relation to other things. 

Graphics on the drawing 
canvas

To group objects:

1. Select them all by holding down 
the CTRL key as you click each 
object. 

2. Right-click the selected objects, 
point to Grouping on the 
shortcut menu, and click Group.
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Copy, group, or rotate images

Rotate. Usually when you insert an 
image, it's oriented vertically—but 
you're not stuck with that angle. 
When you click an image on the 
drawing canvas, you'll notice a 
green selection handle at the top: 
that's the rotation handle. 

Graphics on the drawing 
canvas
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Suggestions for practice

1. Insert and color an AutoShape.

2. Copy the AutoShape and group the two images.

3. Resize, rotate, and reposition the grouped images.

4. Resize and reposition an image in relation to text.

5. Resize the organization chart.

Online practice (requires Word 2003)

http://office.microsoft.com/training/training.aspx?AssetID=RP010265251033&CTT=6&Origin=RP010265231033
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Test 3, question 1

You insert a bitmap image that you have on your 
computer. Not only is the image the wrong size, 
it's in the wrong place. How would you go about 
fixing the image? (Pick one answer.)

1. You cannot resize the image, but you can move it by 
cutting and pasting it elsewhere. 

2. By deleting the image and trying again. 

3. By dragging it into the correct position, and then using 
the resize handles to shrink or expand it. 
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Test 3, question 1: Answer

By dragging it into the correct position, and then using the 
resize handles to shrink or expand it. 

With a few variations, moving and resizing most types of 
images works on the same basic principle: To move it, you 
click the image to select it, and then drag it; to resize it, you 
use the resize handles on the sides and at the corners.
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Test 3, question 2

You insert an arrow using the AutoShapes toolbar. 
How would you rotate the arrow? (The arrow is on 
the drawing canvas.) (Pick one answer.)

1. Use the green handle at the top of the image. 

2. Use any of the clear, round handles on the edges or in 
the corners. 

3. You cannot rotate an AutoShape. 
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Test 3, question 2: Answer

Use the green handle at the top of the image. 

The round, green circle at the top of the image is the 
rotation handle, which you drag in the direction you want to 
rotate.
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Test 3, question 3

An inline graphic is: (Pick one answer.)

1. A graphic that is in a list. 

2. A graphic that is not tied to any text. 

3. A graphic that acts like a text character. 



Insert and position 

graphics

Test 3, question 3: Answer

A graphic that acts like a text character.

An inline graphic is in line with text and acts like any other 
typed character.



Lesson 4

Floating graphics and keeping 
them in place
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Floating graphics and keeping them in place

Keeping your graphic exactly where 
you want it involves specifying how 
the graphic and text interact. 

The first step in understanding this 
process is knowing about floating
graphics.

A floating graphic is on a 
different layer from text.
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Create a floating graphic

You can change a graphic from 
inline (acting as a text character) to 
floating by changing the text-
wrapping style; any wrapping style 
other than In line with text will 
create a floating graphic.

Text-wrapping options on 
the Layout tab

First, position the graphic where you 
want it. Then fine-tune its position 
within the surrounding text.
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Create a floating graphic

Text-wrapping options on 
the Layout tab

1. Right-click the image, and then 
click the relevant Format
command. 

2. On the Layout tab, use the 
Wrapping style options to 
specify how the image and text 
work around each other. 

3. With a floating graphic, you can 
also specify the Horizontal 
alignment. 
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Wrapping styles

Here are examples of wrapping 
styles, and when you might use 
them:

1. Square places the graphic in an 
invisible box that fits its largest 
dimensions, and then wraps text 
around the sides of the image.

2. Tight has a positioning effect 
similar to Square, but text fits 
tightly around the edges of the 
actual image as opposed to the 
invisible box.

Different wrapping styles
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Wrapping styles

3. Behind text places the image 
behind and showing through the 
text. The graphics layer is 
underneath the text layer. 

Different wrapping styles

4. In front of text places the 
image in front of the text, 
obscuring it. The graphics layer is 
on top of the text layer. 

5. In line with text puts the image 
inline—not floating—for when you 
want the image to act as a text 
character. 
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Fine-tune text wrapping

There are a few ways to fine-tune 
your text wrapping: 

• On the Layout tab, click the 
Advanced button to open the 
Advanced Layout dialog box.

• On the Text Wrapping tab you’ll 
see two more text-wrapping 
styles. Further text-wrapping 

options
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Fine-tune text wrapping

• Through is similar to Tight, but 
if the graphic has an open space 
in it, the text continues through 
the open space. 

Further text-wrapping 
options

• Top and bottom places the 
graphic with a full line of text just 
above its topmost part and a full 
line of text just below its 
bottommost part with no text on 
either side. 
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Fine-tune text wrapping

If you need supreme accuracy when 
using a wrapping style where the 
text goes around the picture:

1. Select the graphic, and click the 
Text Wrapping button on the 
Picture toolbar. 

2. Then, click Edit Wrap Points. 
The graphic will be surrounded by 
small squares that you can drag 
to adjust exactly where the text 
wraps around the graphic.

Further text-wrapping 
options
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Keep a floating graphic in place

You've read all about floating 
graphics, but how do you keep the 
pesky things where you want them? 
The key to getting them to stay put 
is positioning them accurately.

Keep your graphic in place by using 
the options on the Picture Position
tab of the Advanced Layout dialog 
box.

The Picture Position
tab
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Keep a floating graphic in place

For example, imagine writing a 
newsletter in which you want a 
particular picture to remain with the 
related story. In this case, you 
would position the picture relative to 
a related paragraph. 

The Picture Position
tab

But if you wanted a picture to stay 
on the first page regardless of any 
text being moved around, you would 
position the picture relative to the 
page.
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Anchors

When you've got your graphic in 
position, you might want to modify 
its position after you've seen it in 
place with the text. 

Behind the scenes, when you 
position a floating graphic, Word is 
"anchoring" the graphic relative to 
whatever you've positioned the 
graphic by (paragraph, page, and 
so on).

The anchor symbol 
appears next to where 
the graphic is anchored.
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Anchors

You can see the anchor by clicking 
Show/Hide ¶ on the Standard
toolbar. The graphic has to be 
selected to see the anchor.

The anchor symbol 
appears next to where 
the graphic is anchored.

You can move an anchor by 
dragging it to a different position in 
the document. This will only move 
the anchor—not the graphic. 
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Suggestions for practice

1. Change text wrapping.

2. Edit wrap points.

3. Position a graphic relative to a paragraph.

4. Work with anchors.

5. See the change in relative positioning.

6. Lock the anchor.

Online practice (requires Word 2003)

http://office.microsoft.com/training/Training.aspx?AssetID=RP011443981033&CTT=6&Origin=RC010264821033
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Test 4, question 1

How do you change an inline graphic to a 
floating graphic? (Pick one answer.)

1. Place the graphic on the drawing canvas. 

2. Change the text-wrapping style of the graphic. 

3. Change the graphic properties to floating. 
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Test 4, question 1: Answer

Change the text-wrapping style of the graphic. 

Any wrapping style other than In Line With Text creates a 
floating graphic.



Insert and position 

graphics

Test 4, question 2

You want to keep a graphic in a certain place on 
a page regardless of the text around it. What 
should you do? (Pick one answer.)

1. Choose a wrapping style that makes it a floating graphic, 
and then position it relative to the page. 

2. Write all the text first, and then insert the graphic and 
position it. 

3. Choose a wrapping style that makes it a floating graphic, 
and then position it relative to a paragraph. 
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Test 4, question 2: Answer

Choose a wrapping style that makes it a floating graphic, 
and then position it relative to the page.

This is exactly what you need to do.
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Test 4, question 3

How can you see the anchor position of an 
anchored graphic? (Pick one answer.)

1. Select the graphic. Then, in the Advanced Layout
dialog box, select the Show Anchor check box. 

2. Select the graphic. Then, on the Standard toolbar, 
click the Show/Hide ¶ button. 

3. Select the graphic. Then, on the View menu, click 
Anchor. 
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Test 4, question 3: Answer

Select the graphic. Then, on the Standard toolbar, click the 
Show/Hide ¶ button.

This will display the anchor, as well as all the other 
paragraph marks.


